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Introduction 
The purpose of this guide is to allow users of the Lentune Trade Desktop to work productively and 
effectively with the software. It should be read by all users of the system. Its major sections are  

 Installation and Getting Started 
 User Interface  
 Supplier Details 
 My Details 
 Troubleshooting 

 
If you are reading this guide, you have probably downloaded it from the relevant part of the 
Wholesaler Web Site. You should also download the Lentune Export File Specification Document, 
if you intend to download Supplier Invoices and Prices for use with a spreadsheet or other 
software. 
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Installation and Getting Started 

Contacting your Wholesaler 

Web Page 
The Wholesaler may direct you to the correct part of their web site to get started. There should 
be a page on their web site with links to this guide and other documentation, and instructions and 
a link for downloading the program.  

User ID, Password, Account Access 
Your Wholesaler, upon request, can assign you a User ID and Password to allow you to use the 
Lentune Trade Desktop. Full or limited access may be requested for more than one user to access 
your account, using a different User ID and Password. Ask for a user to have ‘Account Access’ to 
allow them to use all functions of the system. Otherwise very little is allowed. 
 
The Wholesaler will inform you of the Web Site Address to type in when logging for the first time. 
 
In order to use the software for invoicing your own customers you will need to provide your GST 
Number to the Wholesaler so they can enter it into the system. 
 
If you wish to have a password changed or a User ID withdrawn, please contact the Wholesaler.  

Pre-Requisite Software 
A Microsoft Windows Operating System with its latest Service Pack installed. 
Windows 2000, XP or Vista is recommended. 
Microsoft .NET Redistributable Package, version 2.0 or later, with its latest Service Pack 
installed. 
Microsoft Windows Installer, version 3.0 or later. Version 3.1 is recommended. 
Microsoft Internet Explorer 5.01 or later. The latest version with its latest Service Pack is 
recommended. 
An up to date version of a Portable Document Format (.pdf) reader such as Adobe Acrobat 
Reader. 

How the Lentune Trade Desktop Works 
Your Wholesaler provides the program as a service to you.  
 

 You have up to date access to your transactions with the Wholesaler 
 You can download supplier invoice and price files 
 You can prepare and manage quotes and estimates for your prospects 
 You can invoice your customers and send them statements 
 You can manage your customer accounts, payments and overdues 

 
You operate the software through a copy of the program downloaded and installed on your 
computer. You may install it on multiple computers. 
 
In response to your actions on windows forms, requests are sent to the Wholesaler’s Web Site, 
and data is returned to you. This depends on you having a reliable internet broadband 
connection, configured to access your supplier’s Web Site. 
 
All the important data is held as part of a database at your Wholesaler. Your data is only 
accessible by your User ID and Password, and only through the Lentune Trade Desktop software. 
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Download and Installation 

Install from Web Site 
Lentune Trade Desktop is a program you download from your Wholesaler’s Web Site or install 
from a CD provided by your Wholesaler. The program should be available via a link at your 
Wholesaler Web Site, as directed by your Wholesaler. Brief installation instructions are provided 
on the Wholesaler’s Web Page for Lentune Trade Desktop. 
 
The program is packaged as a Microsoft Windows Installer (.msi) file. The Wholesaler may also 
supply the file as a .zip file, which may be necessary to download instead if your firewall does not 
allow you to download .msi files. In this case you need to save and unzip the file to expose the 
.msi file. 
 
Depending on your browser, you may be offered the choice to run or save the 
LentuneV7TradeDesktopInstaller.msi file. 
 
If you choose Save, you can navigate to the file using Windows Explorer and double click to start 
the installer wizard. 
 
If you choose Run, the installer wizard leads you through the installation process. Respond OK to 
the prompts for a default install. 
 
After installation you should have a Lentune Trade Desktop (LTD) shortcut on your desktop. 
The program is also available through Start->All Programs->Lentune->Lentune Trade Desktop. 
 
You may drag the desktop shortcut to the Quick Launch task bar located at the bottom of your 
screen. You may have to [Mouse, Right-Click]->Unlock the taskbar to do so. 

Uninstalling 
Should you wish to uninstall the program, Start->Control Panel->Add or Remove Programs will 
list Lentune Trade Desktop. Choose it and the Remove button. This may be necessary when 
upgrading to a later version of the software. 
 
The default folder for the program files is  
Program Files->Lentune Ltd->Lentune V7 Trade Desktop. 

Upgrading 
You may be advised by your Wholesaler to upgrade the program from time to time. To do so, first 
uninstall the program, and then follow the Download and installation process above. Your data 
will not be lost or affected by a software upgrade. 

Starting and Stopping the Lentune Trade Desktop 
 
Start the system via:  

 LTD Icon Desktop Shortcut  
 LTD Icon Quick Launch Task Bar  
 Start menu->Programs->Lentune->Lentune Trade Desktop.exe 

Login Form 
If you have not formerly checked ‘Remember Me’ during a previous login, the Lentune Web 
Service Login Edit form is presented. 
 
Fill in the User ID, Password, Web Site Address and Database Name as provided by your 
Wholesaler.  
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Only if your company runs a Proxy Server to access the Internet, enter the Proxy Server User ID 
and Password as provided by your company IT Administrator. 
 
If you wish to avoid filling the Login Form every time, check the ‘Remember Me’ box 
 
Choose the Login Button. The main window of the Lentune Trade Desktop should now display. 
 
Once the Menu bar becomes available you are ready to begin. The Receivable Account is your 
account at the Wholesaler, accessible only via the User ID and Passwords which have been set up 
by the Wholesaler to have Account Access. 
 
If  

 You have reset ‘Remember Me’ via  
My Details->My Setup Details->Reset Login Details button 

 Requested a password change. 
 Your password had been changed by the Wholesaler 

 
…you are required to repeat filling in the above Login Form. 

User Interface 
It is assumed that all users understand the standard classic Windows interface, how to choose 
and manipulate windows controls via both the mouse and the keyboard and the meaning of visual 
clues such as greying out for disabled. Non standard or additional features are covered below. 

 
It is recommended that you use the system as you read the information below to familiarise 
yourself with how to operate the controls. 

Main Window Components 
The minimum screen size supported is 1024 by 768 Pixels. If scroll bars appear on the main 
window, or you cannot see the entire window, you need to adjust your Microsoft Windows screen 
definition to at least this size. [Mouse, Right-Click] on your desktop and choose Properties, then 
the Setting Tab. Move the Screen Resolution slider. 
 
Maximize, Minimize or Restore Down using the standard controls at top right. Drag with the 
mouse on a window edge or the bottom right corner to re-size.  
 
Your User ID is displayed in the Title Bar of the main window with the Wholesaler’s Name and the 
application name - Lentune Trade Desktop. 
 
To stop the Lentune Trade Desktop choose File->Exit, LTD Icon (top left)->Close or click on the X 
in the top right of the main window. You may be prompted to save data. 
 
The Lentune software uses a Multiple Document Interface (MDI) in which the main parent window 
has a client area where multiple active child windows can be open and used. 
 
The main window major elements, from top left to bottom right, are: 

 Title Bar with the User Id, etc. 
 Menu Bar  

- Click or select via keyboard Alt then arrow keys and to see/launch options or Alt-x where 
x is a letter corresponding to the first or underlined menu character. 

 Client Area – Main area for windows activated via Menu Bar choice. 
 Status Bar at bottom –instructions, information and error message location. 

 
Your staff are shown all menu options but if they choose an option you have not given them by 
agreement with the Wholesaler they get refused with a security message. 
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Menu Items 
You can activate windows to accomplish tasks using these. 

 
 File->Exit Use this, the Icon at top left corner or the [X] in the top right corner the main 

window of to quit/leave the system. You may receive messages requesting you 
close the child windows in a particular order. 

File->Close All Use this to close all child windows in the Client Area. You may receive 
messages requesting you close the windows in a particular order. 

File->Cascade 
Tile Vertical 
Tile Horizontal 

By Default the active child window obscures the inactive ones. Use these 
options to present at least part of the inactive windows. 

Windows All the active windows open in the client area, even if hidden by others, are 
displayed as a numbered list below this Menu Item.  The currently active 
window has a tick. Activate a different window via [Mouse Click], [Alt-W, 
number] or [Alt-W, Tab/Down Arrow, Enter]  

Supplier Details Displays the Supplier Account, Invoices, Current Quotes, Prices or Packing 
Slips child window depending on the menu choice. These to allow you to obtain 
information from the Wholesaler. 

This menu item is only usable by users who have Account Access. 

My Details Most menu items here are to allow you to manage business with your own 
customers. Menu items for Invoices, Statements and Trial Balance Report are 
only usable by users who have Account Access 

My Details-> 

My Setup Details 

The My Setup Details form allow you to ‘Unremember’ your login details so you 
can re-fill in the login form next time, limit the number of lines returned in 
searches, and set messages for display on your customer invoices and 
statements.  

This menu item is only usable by users who have Account Access. 

My Details->My 
Report Details 

Give access to a set of reports. The reports are presented in a Report Browse 
window, from where they can be exported to files in various formats and 
emailed as attachments via you default email program. 

Child Windows 
Child windows are created using the Main Window Menu. 
 
They have a Title Bar at the top with the name indicating what they do.  
The Top Left and Top Right corners contain controls to close the window.  
There is no Menu Bar. Instead the main window Menu Bar is used.  
Tab controls are sometimes used to allow the form to better organise its data.  
There is usually a row of buttons just above the Status Bar at the bottom. They perform common 
tasks such as saving the contents of the form in the database or escaping from the form without 
saving. 
 
Child windows are typically 800 by 600 pixels in size, which will fill most of the main Client Area 
on a terminal of size 1024 by 768 pixels.  
 
Drag with the mouse on a window edge or the bottom right corner to re-size.  
 
You may also Minimize, Restore and Maximize using the controls at the top right corner. 
 
It is common to have multiple child windows open simultaneously in the Client Area. However 
they may be obscured by the currently active window. Use the Windows Menu Item to bring any 
window in the menu list to the front and make it the active window or use File->Cascade, Tile 
Vertical/Tile Horizontal. 
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Special (non-child) Windows 
The system sometimes opens special windows which are not MDI Child windows, but are 
independent. An example is the Report Preview window. The system may also activate Adobe 
Acrobat Reader, Microsoft Word and Microsoft Excel using documents exported from the system. 
Depending on your role you may need to familiarise yourself with these products.  

Dialogue Boxes 
The system sometimes opens special windows which are not MDI Child windows but ask you a 
question to which you must respond. There are often Yes, No, Cancel buttons, with one 
highlighted as the default action if you hit Enter. 

Searching and Matching 

Search Button 
The Search button is used with a combination of values in other controls 
 
By filling in more information, less data is returned to scroll though. If no data is returned you 
may need to remove, shorten or correct some search words. 

Code 
This typically contains an upper case single word, which will be matched to the item’s Code using 
‘begins with’.  

Keywords 
Many windows contain a Keyword field. Enter groups of number and characters separated by 
spaces and Search for records matching ALL the ‘words’ 

Numeric Fields 
The search criteria for numeric fields depends on context, but is often a match on ‘less than or 
equal to’, rather than an exact match. 

Start and End Dates 
These may be given independently.  If given, they are matched using ‘greater than or equal to’ 
and ‘less than or equal to’ some date property of the item, depending on context. 

Drop Downs 
Only items which have been marked with the displayed value will be searched for. For example, 
Type of ‘Tax Invoice’ will ignore all Quotes and Estimates. 

Top Number 
By default this is set to 200. Its purpose is to reduce the transfer of data from the web site.  

Active 
By default this is checked. For example if you lose a Quote you can mark it as inactive. Then 
when you search, only the winnable quotes are searched for. 

Special Controls 

Editable Text Fields 
Click on a field or [Tab]/[shift-Tab] to it paints a yellow background and highlights the text 
content for replacement. Click at an insertion point within the text to override the default 
behaviour of replacing the entire field as you type. 
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Form Buttons 
Buttons are used to access functions within the system from the window you are currently in.  
Not all buttons are displayed on every window. Buttons can be activated by [Mouse, Click] or by 
Tab. One Button is usually highlighted. If this is the desired action you may hit Enter, or Tab to 
the desired button and Enter. 

Date Control  
The standard form for date input is dd/mm/yyyy. dd/mm/yy is also accepted. Complete the field 
by using Tab or Alternate Tab (Numeric Keypad +). 
 
To speed data entry some special values may be entered: 

 T=today 
 Y=yesterday 
 +n, -n  = n days from today or the original date in the field. 
 n = nth day of current month. 
 ME1-ME12 = last day of month, calendar  year months.  
 MB1-MB12 = first day of month, calendar year months. 
 M+n, M-n = n months from today or the original date in the field. 
 dd/mm is accepted. The current year is assumed 
 9999 is treated as dd/mm. 
 999999 is treated as  dd/mm/yy, 99999999 as dd/mm/yyyy. 
 ddMMM, dd.MMM. or dd/MMM (where MMM is a standard month abbreviation or 

month name) is accepted. 
 

Separators can be . / - or space. 
Invalid dates are assumed to be Today. 
Depending on context, the date you enter may be transformed into an equivalent Month End 
date.  

Grid Control 
A grid presents data in rows and columns, with column headers. Many functions of the grid are 
accessible by keyboard but some advanced options require the use of the mouse. The area 
showing lines may have vertical and horizontal scroll bars. 

Header Column Cells 
These describe the type of data in their column. 
Re-size a column by [Mouse, dragging] the line between the Header Column cells. 
Move a column by [Mouse, dragging] the Header Column cell. 
Sort the Grid by a column by [Mouse, Click] on the Header Column cell, and again to reverse the 
sort sequence. 

Main Grid Area 

Scrolling 
When scrolling is necessary, horizontal and/or vertical scroll bars appear. These follow 
conventional Window mouse behaviour. 
After you tab to or focus on a grid:  

 The [Page Down] and [Page Up] keys scroll by a displayed page worth of Rows. 
 When Arrow Keys reach an edge, they scroll a row/column at a time.  

Selecting Rows 
[Mouse, Click] to select a row (and sometimes cell). 
[Shift + Mouse, Click] to select contiguous rows. 
[Ctrl + Mouse, Click] to select additional non-contiguous rows. 
After you Tab to a grid you may move to a line and cell using Arrow Keys.  
 
The selected line is highlighted by colour. 
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The focused cell (if allowed by the grid) is highlighted by a special border. 

Add, Edit, Delete 
Depending on context you may be allowed to Add, Edit or Delete rows. 
[Mouse, Right Click] shows a context menu allowing you to Add, Edit or Delete the row. 
Select row, [Edit (F12)] or [Mouse, Double Click] on a row to invoke an Edit window for the row. 
Use [Insert] to add a row. Some of the row contents may be used as defaults in the Edit window. 
Select row, [Delete] to delete a row. 

Editing Cells 
Depending on context you may be allowed to edit the contents of a cell. 
 
Using the Keyboard, once you have tabbed to a grid collection, you can use the arrow keys to 
focus on a row and column cell, then [More Info (F2)]. See below for recommend mouse actions. 

Other Actions on a Row 
What happens to the selected row or cell depends on the action key or mouse choice you make 
and the purpose of the window containing the grid. 
 
Many grids display read only data. [Mouse, Double-Click] may display further detail, such as by 
running a report or displaying a window form. [Mouse, Right Click] may display other context 
menu options. [Enter] may take the default action for a row. 
Column cells section above. 

Tab Control 
Subsets of the field controls on many Edit windows are organised using Tab controls which 
present subsets of the window in a style similar to a filing cabinet with a ‘tab’ per folder. 
You choose a tab to bring to the front using [Mouse, Click] or, if already focused on a tab, using 
the arrow keys and [Space Bar]. Moving away from a tab often results in some aspect of the data 
to be saved in the database.  

Splitters 
A thick black vertical or horizontal line within a form is a Splitter. Drag the splitter to enlarge or 
reduce areas of the form. 

Edit Windows 
These windows may appear through choosing from the ‘My Details’ Menu. 
These windows usually allow the user to see or update aspects of one of the items of the system 
or some form of business transaction. The more complex items will have controls over and above 
the regular Windows controls.  

Standard Edit Buttons 
Whilst an Edit window may contain many buttons related to its function which perform other 
tasks, there are a common set of buttons listed below on most Edits. 

Save (F10) 
Saves the item, and any ancillary data which was changed, in the database, then closes the form.  

Accept (F10) 
This is typically in an Edit (child form) opened from within another Edit (parent form). 
It remembers the changes in memory to return to the parent form, then closes the child form. Its 
parent form Saves the data to the database later, or can Cancel. An example is an Invoice Line 
Edit within an Invoice Edit. 
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Cancel(ESC) 
Closes the form without saving the item or printing documents. You may be presented with a 
‘Warning: Changes not saved’  Save Changes? dialog box with Yes, No and Cancel buttons. This 
details the data which will be lost if you choose the No button. 

Report Preview Window 
After the report completes it is presented in a Report Preview window. This is NOT a typical child 
window of the system, but an independent window, which either may be 

 minimised or behind 
or 

 maximised and in front of  
 
… the main Lentune window  If behind, it will be on the task bar in the list of windows above your 
Lentune System Icon, and named Preview. Choose it and it will display maximised in front of the 
main Lentune window.  [Alt-Tab] can be also be used to select and activate it. 

Report Format 
Depending on the report it may be in landscape or portrait format.  Most report pages have a title 
area with the organisation name, report name and date, with a sub-title area containing selection 
criteria used. A footer area may contain date and time, the report name and ‘Page N of M’ 
information. 
Reports are often sorted and grouped, with a grand total area on the last page. 

Controls 
The report browser contains a Menu Bar and a Tool Bar just below it which allow you to find text, 
print on a default printer or via a Print Dialog, choose page format, Zoom, Scroll, etc. 
 
Depending on context there may be a vertical and horizontal scroll bar. You may use these, the 
‘Hand’ tool or Arrow Keys to scroll. 
 
If the report is more than one page long, toolbar icons permit you to move to the next and 
previous, first and last page. The [Home] key takes you to the first page and the [End] key to the 
last page. The [Page Up] and [Page Down] keys scroll a page at a time. 
 
Towards the right of the toolbar is an Export icon and a Send via Email Icon. 
They permit you to save that report in a wide variety of formats, with an option to open the file 
using the default software assigned to that format or to email it using your default mail program.  
If saved in a file format with good formatting support such as Excel, PDF or Rich Text Format, 
most of the visual formatting of the report is preserved in the saved file. It is often useful to save 
as a Comma Separated Variable (.csv) file then open that in a spreadsheet in order to remove the 
report formatting and allow spreadsheet capabilities such as sorting to be performed. 

Adobe Acrobat Reader 
It is common for reports to be exported as PDF documents. The file type .pdf must be associated 
with a Portable Document Format reader. Usually Adobe Acrobat Reader is activated to display 
such documents. All users should familiarise themselves with the Adobe Acrobat Reader 
application. From within this reader you should be able to print the document or email it as an 
attachment in .pdf format. 

Some Common Keyboard Shortcuts and Mouse Actions 

Context menus 
[Mouse, Right Click] is used extensively throughout the system to present you with action options 
such as:  
Add, Edit or Delete 
... or to present context property sheets. 
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Some Windows Defined Keys 
 [Alt-F4] [ Esc] Close the window without saving. This is 

equivalent to a Cancel button or clicking on 
the X in the top right corner. 

 [Alt] If there is no active window this key puts 
you into the Menu bar. You can then use 
arrow keys to view/select a menu item, 
then [Enter]  

 [Alt-X] Activates the control with an underlined 
letter of X. For example Alt-W in the Main 
window is equivalent to [Mouse, Click] on 
the Windows menu item.  

 [Enter] Takes the action corresponding to the 
default (focused) button. 

 
All of the Window controls are selectable and can be activated via the Mouse. 
Most are also selectable through use of the Tab key. 

Lentune Defined Action Keys 
These keyboard shortcut keys allow the keyboard to be used efficiently to achieve system tasks. 
Where they correspond to a Button control, they are shown in brackets in the Text on that 
button. When available as an alternative to a [Right Click] Context Menu, they are listed there.  
A separate document, Help->Keyboard and Mouse Quick Guide, is a 2 page document showing 
the most common shortcuts, also shown here. 
 
Key Meaning Description 
Escape Abort Corresponds to the Cancel(Esc) button in Browse and Edit 
Numeric 
keypad ‘+’ 

Alternate Tab 
The ‘‘Add” key 

Can be used instead of Tab key, and Shift-+ instead of Shift-Tab 
for movement into and out of controls. 

Insert Insert Corresponds to the Add context menu in a grid 
Delete Delete Corresponds to the Delete context menu item in a grid 
F2 More 

Information 
In a Lookup, display a browse list matching the string in the 
lookup field, with Enter meaning Select. Roughly equivalent to Tab 

F3 Summary In a lookup, show a summary window for the field if it has one. 
For example a Receivable Account lookup shows contact 
information, aged balances and a monthly sales history. 

F2/F5 Search Corresponds to the Search button in a Browse 
F6 Clear Corresponds to the Clear button in a Browse or Lookup 
F8 Add New 

Record 
Add, usually taking the highlighted row into account as the insert 
point.  

F10 Accept Corresponds to the Save, Ok button in Edit.  
F10 Edit record Edit the highlighted row in a grid 
F12 Edit record Edit the highlighted row in a grid 
Shift-F9 Delete Record Delete the highlighted row in a grid 
 

Context Menu Items 
 
Within a window, [Right Click] may present a Context Menu. Some or all of the items below may 
be presented, depending on the type of form. 
Set Defaults  Remember values in fields 
Clear Defaults  Clear remembered values 
Add New Record  F8  
Edit Record  F12  
Delete Record  Shift-F9  
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Edit Record (alternate Shortcut)  F10  
Search  F5  
Search (Alternate Shortcut)  F2  
View Summary  F3  
Clear  F6  

Supplier Details 
This part of the software allows you to access your account and transactions with the Wholesaler, 
to allow you to reprint or otherwise use the data, and to download invoice and price data. This 
menu item is only usable by users who have Account Access, .as agreed with the Wholesaler. 

Account 
This form displays a grid of Account Month End rows. Double Click to drill down to a grid of 
invoices and credits for the month.  Within that grid, double click on an invoice row to display a 
copy of the Invoice/Credit. 

Invoices 
You may search for invoices between 2 dates and/or by a combination of your order number/ 
reference provided to the supplier when purchasing the goods. This corresponds to the text in the 
Client Order No and Reference fields shown on the printed Invoice. 
 
If you select a row in the grid, double click displays the printed invoice with a diagonal red 
watermark indicating it is a Copy; Quick Invoice Preview shows the invoice in a form. 
 
The Export Invoices button downloads the data corresponding to the search as a comma 
separated value (.csv) file which can be loaded into a spreadsheet or other software. The format 
is documented in the separate Lentune Export File Specification Document. 

Quotes 
A grid showing your unexpired Supplier Quotes is presented. Informal, pricing only, quotes are 
not displayed, only formal Contract Quotes or Branch Quotes. Double Click on a row to obtain the 
Quote Document. 

Price 
The Keyword text box allows you to enter one or more words or parts of words. An Example 
search string double 10A whi V 692 produces a short list of products for a 10 Amp double 
outlet vertical white switch. The more you type the less you have to scroll through. The ‘Search 
for Stock’ button fills the grid.  
 
The ‘Download Full Stock File’ button downloads a large Comma Separated Value (.csv) for import 
into a spreadsheet or other software. It may take several minutes on a Broadband connection to 
download the file. The status bar shows progress.  
 
It contains Stock Code, Trade Price and Your Price. The format is documented in the separate 
Lentune Export File Specification Document. 
 
The ‘Download Bought Items’ button downloads a file in the same format, but only includes items 
you have ever bought.  
 
The ‘Create Lentune Import Files’ is for use by customers using the legacy Lentune V5 
application. 
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Packing Slips 
This form displays a grid of Packing Slips which may not yet been invoiced by the Wholesaler. 
Double Click to drill down to the lines on the Packing Slip, presented in the Packing Slip Details 
tab. Preview Packing Slip displays a copy, usually with a red diagonal watermark saying it is 
subject to change. 

My Details 
This part of the software allows you to access your purchase transactions with the Wholesaler, 
and add in your own stock or labour for the purpose of developing quotes or estimates and on 
charging to your customers. You can also manage your banking and customer payments. 

Location of Data 
Note that all data resides on the Wholesaler’s computer, and is saved in a part of their database 
accessible by you. The only data saved on your computer is Supplier Invoice or Price data you 
download or saved Portable Document Format (.pdf) files which are a by product of your 
previewing reports, invoices, etc. 
 
You also obtain supplier prices via the Supplier menu and can download a price file. 

Typical Process for Selling to Customers 
The purpose of items under the My Details menu is to allow you to prepare quotes and estimates, 
ensure that products purchased for a job are assigned to a customer invoice at a profit, and to 
allow you to manage invoices, account balances and payments by your customers. 

Clients 
Before preparing a quote for a new customer, use the My Clients menu item to add a client record 
and enter details you wish to record about the client. Besides contact information and a notes 
area you can set either a default mark up on cost or discount on trade for the client. You can also 
set a Client to Active via a check box. Inactive clients don't show by default in the search lists. 
 
You should allocate a unique code for each client. This will make it easy to choose when preparing 
quotes, etc. 
 
If at any time you wish to search for or update a client record use the My Clients menu item, 
Select the client to update and choose the Edit Highlighted Client button.  

Products and Prices 
The supplier's products, costs and trade prices will be available when preparing quotes, etc. You 
can also manage your own 'products', be they material or labour charge rates, travel charges, 
freight, etc. 
 
Add or Edit your products, costs and prices using the My Stock menu item. Choose the Add New 
Stock button, enter the details and choose Accept button. 
 
You should allocate a unique code for each product. This will make it easy to choose when 
preparing quotes, etc. 
 
If at any time you wish to review your prices, use the My Stock menu item, select the stock item 
to update and choose the Edit Highlighted Stock button. From that point onwards the new prices 
and costs will be used. Already prepared quotes, etc. will use the old prices and costs. 

Quotes or Estimates 
To prepare quotes or estimates use the My Invoice / Quotes / Estimates menu item to access the 
Trade Invoice Edit form. Use the Type dropdown to choose whether you are making a quote or 
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estimate, and the Status dropdown to indicate the stage the quote is at (To Send, Sent). You can 
add lines for items you purchased from the supplier for stock and your own product items such as 
labour charges using the area at the bottom of the ‘Manage Lines’ tab. Select a line in the top 
grid where you want to insert the new line. Choose ‘Supplier Stock’ or ‘My Stock’ tab. 
Search for and select the stock item, then complete the quantity, EITHER Discount OR Markup if 
appropriate, and Description if appropriate. The line is added after the selected line in the top 
grid. 
 
Note: If you choose the wrong one of Discount or Markup, tab to the wrong one and enter 0 and 
tab. This will open the other one for editing. 
 
The Trade Invoice Edit ‘Manage Lines’ tab also allows you to change the sort order of the lines on 
the invoice and to edit all the fields on a line. Select and Edit the line.  
 
You can Print or Email a quote or estimate via the Preview button which displays the document in 
your PDF reader software.  

Preparation of Invoices 
After you win the job you can use the Type dropdown to turn the document into an Invoice. 
Alternatively you can add a Trade Invoice using the Trade Invoice Edit form.  
 
You should add a due date, for example 20th of next month, at that stage so that the customer's 
expected payment date is recorded, and you can use the Status dropdown to mark the work as In 
Progress. 
 
If you purchase goods from the supplier for a job, you can assign them to a customer invoice at a 
profit, using the Assign Supplier Invoices form. One mode of operation is to assign or mark as 
processed all that you purchase, so the left hand grid becomes empty. This ensures you at least 
consider charging for everything you buy. 
 
You can add or edit invoice lines for items you purchased from the supplier for stock and your 
own product items such as labour charges using the area at the bottom of Assign Supplier 
Invoices and the Trade Invoice Edit. The line is added after the selected line in the top grid. 
 
You can Print or Email an invoice via the PDF reader software.  

Sending Statements 
You can print Statements via the PDF reader software. 

Following Up on Payments 
You can use the Outstanding Invoices and the Trial Balance reports to follow up on payments. 

Processing Payments 
When customers pay, you should enter them using the Daily Banking menu item. This posts the 
payments to the customer account. You should also allocate them to invoices using the Payments 
tab of My Invoices/Quotes/Estimates->Trade Invoice Edit. This ensures the invoices are marked 
as paid, so they won’t show as overdue or on the Outstanding Invoices report. 

My Details Menu Items 

Assign Supplier Invoices 
This form allows you to create a new Trade Invoice for you to charge your customers. 
You can use 

 Items you purchased from the Wholesaler 
 ‘Supplier Stock’ such as cable from your own supplies 
 ‘My Stock’ lines such as labour costs 

and add them to the Trade Invoice, adding a discount on trade or a markup on your cost. 
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You can also add lines to an existing Trade Invoice. 
 
The Save and Continue button should be used on a frequent basis to protect you from unreliable 
communication over the internet. The Accept Button saves your work and quits the form. 

My Invoices / Quotes / Estimates 
This allows you to search for, Edit, Preview (to print) or add Invoices, Quotes and Estimates, and 
to change Estimates and Quotes into Invoices. Double Click on a grid line to Edit. The Due Date is 
used for accounting purposes for your Aged Trial Balance and managing overdue accounts.  

My Daily Banking 
This form allows you to add payments made by your customers and post them to their account. 
This menu item is only usable by users who have Account Access. 

My Clients 
This allows you to add, search for and Edit your clients, including contact information. You can 
also set a standard invoice discount on trade or markup on cost. 

My Stock 
You can add or edit Stock records which could be actual material but could also be hire charges, 
freight or hourly labour charge rates. You can record both a cost and trade selling price. 

My Setup Details 
The My Setup Details form allows you to:  

 Reset (‘Unremember’) your login details so you can re-fill in the login form next time 

 Limit the number of lines returned in searches 

 Set messages for display on your customer invoices and statements.  

This form is only usable by users who have Account Access. 

My Reports 

Outstanding Invoices 
This is a report of customers who owe you money. 
This menu item is only usable by users who have Account Access. 

Trial Balance Report 
This is a detailed showing the up to date account balance and overdue status of your customers. 
This menu item is only usable by users who have Account Access. 

Client Summary 
This is a report of client contact information. 

Statements 
This is a statement report for you to send to customers who have outstanding balances. Within 
My Setup Details there is a standard message to appear on all statements, which could be for 
example your bank account details. 
 
This menu item is only usable by users who have Account Access. 

Invoice/Credit Summary 
This is a detailed, or optionally summary, report showing invoices and credits with your 
customers. You can optionally select an individual client and from or to dates. 
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Payments  
This is a detailed, or optionally summary, report showing payments by your customers. You can 
optionally select an individual client and from or to dates. You can use this to take to the bank 
with your daily banking payments, as entered below. 

Trouble Shooting 

Pre-Requisite Software 
If your software is not as specified in the pre-requisite software list and appears (mostly) to work, 
then fine. However neither your Wholesaler not the authors of the software have out of date 
computer software or old or non-Microsoft operating systems with which to test or fix software 
problems unique to you. There is no point in asking them to unless you wish to pay for the 
computers, software, time and effort involved in solving your unique problem. 

Internet Access 
The software is intended to be used over broadband Internet using Port 80, the standard used for 
issuing HTTP requests to web servers. 

Is the Wholesaler Web Site Available? 
You should use your browser to access the Wholesaler’s web site by typing the Web Site Address 
you typed in to the login screen. You should get a HTTP 403 Forbidden response, or a web page. 
Now append /webservice.asmx to that address. You should get a page entitled WebService, with 
a list of functions provided by the Lentune Web Service. If you do not, either the Wholesaler web 
site is not available (their problem) or you cannot contact it (your problem). 

Invalid User ID or Password 
Contact your Wholesaler. 

Screen Resolution 
The minimum screen size supported is 1024 by 768 Pixels. If scroll bars appear on the main 
window, or you cannot see the entire window, you need to adjust your Microsoft Windows screen 
definition to at least this size.  
 
[Mouse, Right-Click] on your desktop and choose Properties, then the Settings Tab. Move the 
Screen Resolution slider. Choose OK. If you are not allowed to do this, contact your own company 
IT administrator or log in on an Administrator windows account. 

Firewalls and Proxy Servers 
If your company imposes restrictions on Internet connections using this kind of software, it is 
your company responsibility to configure the connection to the supplier’s Web Site. It uses only 
Internet Port 80, the normal port also used for web pages. The software supports Basic Proxy 
Authentication, when users have to enter a proxy User Id and Password to gain access to the 
Internet. 

First Point of Contact 
If you are experiencing difficulty using the software or having Internet problems, your first point 
of contact should be your Wholesaler. Their technical staff should help you and will contact 
Lentune if something needs their attention. 
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